
BAB I PENDAHULUAN 

A. Pengertian Animasi Menurut Ibiz Fernandes dalam bukunya Macromedia Flash 

Animation & Cartooning: A creative Guide, animasi definisikan sebagai berikut :  

“Animation is the process of recording and playing back a sequence of stills to achieve 

the illusion of continues motion” ( Ibiz Fernandez McGraw- Hill/Osborn, California, 2002) 

 

Yang artinya kurang lebih adalah : 

“Animasi adalah sebuah proses merekam dan memainkan kembali 

serangkaian gambar statis untuk mendapatkan sebuah ilusi pergerakan.” 

Berdasarkan arti harfiah, Animasi adalah menghidupkan. Yaitu usaha untuk 

menggerakkan sesuatu yang tidak bisa bergerak sendiri.  

Secara garis besar, animasi computer dibagi menjadi dua kategori, yaitu:  

 a. Computer Assisted Animation, animasi pada kategori ini biasanya menunjuk 
pada system animasi 2 dimensi, yaitu mengkomputerisasi proses animasi tradisional yang 
menggunakan gambaran tangan. Computer digunakan untuk pewarnaan, penerapan virtual 
kamera dan penataan data yang digunakan dalam sebuah animasi.  
 b. Computer Generated Animation, pada kategori ini biasanya digunakan untuk 
animasi 3 dimensi dengan program 3D seperti 3D Studio Max, Maya, Autocad dan lain 
sebagainya.  
 

B. Pengertian Multimedia Menurut Rosch definisi animasi adalah kombinasi dari computer 

dan video, menurut McCornick multimedia secara umum merupakan kombinasi tiga 

elemen, yaitu suara, gambar dan teks. Menurut Turban, dkk multimedia adalah 

kombinasi dari paling sedikit dua media input atau output dari data, media ini berupa 

audio (suara, musik), animasi, video, teks, grafik, dan gambar. Menurut Robin dan Linda 

multimedia merupakan alat yang dapat menciptakan presentasi yang dinamis dan 

interaktif yang mengkombinasikan teks, grafik, animasi, audio, dan gambar video. 

Definisi lain dari multimedia yaitu dengan menempatkan dalam konteks seperti yang 

dilakukan Hofstetter, multimedia adalah pemanfaatan computer untuk membuat dan 

menggabungkan teks, grafik, audio, gambar bergerak (video dan animasi) dengan 

menggabungkan link dan tools yang memungkinkan navigasi, berinteraksi, berkreasi, 

dan berkomunikasi.  
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C. Mengenal Animasi Macromedia Flash Animasi pada Macromedia Flash 

sama halnya dengan film secara fisik, yang tersusun dari banyak frame 

dengan gambar-gambar penyusunnya. Frame yang mendefinisikan 

adanya perubahan pada objek disebut dengan keyframe. Dalam dunia 

animasi Web, teknologi Flash kini seolah meraja, bagaimana tidak 

keunggulan-keunggulan yang ditonjolkan membuat hampir semua hal 

yang terlihat rumit menjadi sedemikian simple dan gampang. Dukungan 

terhadap Macromedia Flash belakangan ini semakin luas, format Flash 

Movie *.SWF kini dapat dibuat tidak hanya oleh Macromedia Flash saja. 

Aplikasi lain kini memasukkan *.SWF sebagai format file yang dapat 

dieksport dari aplikasi trsebut, misalnya Adobe Illustrator atau 

CorelDraw. Jika anda telah membuat gambar pada aplikasi-aplikasi 

tersebut, anda dapat langsung mengekspornya ke dalam Flash. Tidak 

hanya aplikasi, bahkan kini scripting PHP pun dapat memuat format 

*.SWF Sesungguhnya Macromedia Flash MX adalah sebuah program 

standar untuk pembuatan animasi high-impact berbasis Web. Anda 

dapat membuat sebuah animasi logo, navigasi control Web site, animasi 

form yang panjang, sebuah website utuh berbasis Flash, atau aplikasi 

web lainnya menggunakan  

program aplikasi ini, anda akan menemukan kekuatan dan fleksibilitas dari program 

Flash ini yang sangat ideal untuk mewujudkan kreativitas anda.  

D. Metode Animasi dalam Flash  
Pada dasarnya Macromedia Flash membagi animasi dalam 2 metode, yaitu:  

a. Frame by frame animation  

Yaitu : Pembuatan animasi dengan cara melakukan perubahan objek pada setiap 

frame secara manual, sehingga dihasilkan perubahan gambar yang teratur. Metode 

ini biasanya digunakan pada animasi dengan perubahan bentuk objek secara terus-

menerus. Misalnya, film kartun.  

b. Tweened animation  

Yaitu : Pembuatan animasi dengan cara menentukan dua poin keadaan pada objek 

awal dan akhir, sedangkan macromedia flash membuat rangkaian gerakan 

diantaranya. Animasi yang dihasilkan menggunakan metode ini adalah gerakan yang 

halus, perubahan letak, ukuran, rotasi, bentuk maupun warna.  
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BAB II MACROMEDIA FLASH 

Seperti yang telah kita ketahui bersama bahwa sesungguhnya Macromedia Flash MX 

adalah sebuah program standar untuk pembuatan animasi high-impact berbasis Web. Anda 

dapat membuat sebuah animasi logo, navigasi control Web site, animasi form yang panjang, 

sebuah website utuh berbasis Flash, atau aplikasi web lainnya menggunakan program 

aplikasi ini, anda akan menemukan kekuatan dan fleksibilitas dari program Flash ini yang 

sangat ideal untuk mewujudkan kreativitas anda. Dari Macromedia versi 4, 5, 6 (MX), MX 

2004, hingga saat ini Macromedia Flash telah mengeluarkan versi terbarunya dalam sebuah 

paket yaitu Macromedia Studio 8 yang salah satunya berisi release terbaru dari Macromedia 

Flash 8. Adapun yang akan kita bahas disini adalah Flash versi 6 atau yang biasa disebut 

dengan Flash MX yang memiliki kelebihan salah satunya adalah dimana dalam tampilan 

panel actionscript Flash 6 kita dapat membuatnya dalam bentuk visual.  

System minimal yang dibutuhkan Program  

Berikut ini adalah spesifikasi hardware dan software yang dibutuhkan program Flash MX 

versi 6 :  

  Untuk Microsoft® Windows: Prosessor Intel Pentium 200 MHz atau lebih, Windows 
98 SE, Windows ME, Windows NT 4.0, Windows 2000, atau Windows XP; 64 MB RAM 
(rekomendasi 128 MB); 85 MB disk space; monitor warna 16-bit dengan resolusi mencapai 
1024 x 768; dan CD-ROM drive.  
 Untuk Macintosh: Power Macintosh dengan Mac OS 9.1 (atau lebih) atau Mac OS X 
versi 10.1 (atau lebih); 64 MB RAM (rekomendsi 128 MB), 85 MB disk space; monitor warna 
16-bit dengan resolusi 1024 x 768; dan CD-ROM drive.  
 

System minimal yang dibutuhkan untuk Flash Player  

Berikut ini adalah spesifikasi hardware dan software yang dibutuhkan Flash player 

untuk dapat menjalankan Flash movie dalam browser:  

  Microsoft Windows 95, Windows 98, Windows ME, Windows NT 4.0, Windows 
2000, atau Windows XP atau lebih; atau sebuah Macintosh PowerPC dengan System 8.6 
atau (termasuk OS X 10.1 atau lebih).  
 Netscape plug-in dengan Netscape 4 (atau lebih) dalam Windows, atau dengan 
Netscape 4.5 (atau lebih) atau Internet Explorer 5.0 (atau lebih) dalam Mac OS.  
 Untuk menjalankan ActiveX controls, Microsoft® Internet Explorer 4 atau lebih 
(Windows 95, Windows 98, Windows Me, Windows NT4, Windows 2000, Windows XP, atau 
lebih).  
  AOL 7 dalam Windows, AOL 5 dalam Mac OS  
 Opera 6 dalam Windows, Opera 5 dalam Mac OS  
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Yang baru dari Flash MX  

Fitur baru dalam Flash MX mempermudah dalam hal penggunaan, kerativitas, dan kekuatan 

dari program ini. Designer yang menginginkan sebuah level control yang lebih tinggi dan 

terintegrasi dengan aplikasi desain standar dunia industri dewasa ini yang memiliki tool-tool 

kreatif yang berguna untuk pembuatan media yang kaya akan isi.  

Fitur baru yang powerful ini memberikan kemudahan dalam hal akses ke kemampuan baru 

yang membuat Flash MX menjadi sebuah aplikasi yang kuat dan menarik dalam lingkungan 

kerjanya. Developer dapat bekerja dengan advanced scripting dan debugging tool, built-in 

code reference, dan predefined components untuk lebih mempercepat proses pembuatan 

aplikasi web yang kaya akan isi.  

Ketika anda bekerja dengan Flash, anda akan dihadapkan pada beberapa tampilan 

Flash yang sangat membantu anda dalam membuat berbagai bentuk objek, diantaranya 

adalah Toolbox, Stage, Timeline, Property Inspector, dan Panel.  

Mengenal Toolbox  
Dalam Flash MX 2004 Toolbox berfungsi untuk menyimpan berbagai peralatan standar 

yang digunakan dalam membentuk atau memanipulasi bentukbentuk yang telah anda buat 

sebelumnya. Terdapat berbagai Tool yang dapat anda pilih beserta berbagai fungsi yang 

berbeda. Toolbox dalam Flash terbagi menjadi 4 bagian, yaitu :  
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1. Tools  

Dalam bagian ini berisi alat-alat (tool) yang berguna untuk membentuk dan merubah 

tampilan dari berbagai macam objek.  

 a. Selection Tool  
Tool ini berguna untuk menyeleksi objek atau merubah bentuk sebuah objek. Anda dapat 
memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan shortcut 
key V pada keyboard.  
 b. Subselection Tool  
Tool ini berguna untuk merubah bentuk sebuah objek pada titik atau nodenya. Anda dapat 
memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan shortcut 
key A pada keyboard.  
 c. Line Tool  
 Tool ini berguna membuat bentuk garis. Anda dapat memilihnya dengan memilihnya 
pada icon dalam Toolbox atau dengan menekan shortcut key N pada keyboard.  
 d. Lasso Tool  
Tool ini berguna untuk memotong objek. Anda dapat memilihnya dengan memilihnya pada 
icon dalam Toolbox atau dengan menekan shortcut key L pada keyboard.  
 e. Pen Tool  
Tool ini berguna untuk membuat bentuk objek dalam titik atau node. Anda dapat memilihnya 
dengan memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key P pada 
keyboard.  
 f. Text Tool  
Tool ini berguna untuk membuat teks. Anda dapat memilihnya dengan memilihnya pada 
icon dalam Toolbox atau dengan menekan shortcut key T pada keyboard.  
 g. Oval Tool  
Tool ini berguna untuk membuat bentuk oval atau lingkaran. Anda dapat memilihnya dengan 
memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key O pada keyboard.  
 h. Rectangle Tool  dan Polystar Tool  
Tool ini berada pada satu tempat, dan anda dapa memilih dalah satunya dengan klik tahan 
pada tool. Tool ini berguna untuk membuat bentuk persegi / kotak (rectangle) dan segilima 
(polistar). Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox atau 
dengan menekan shortcut key R pada keyboard untuk memilih Rectangle Tool.  
 i. Pencil Tool  
Tool ini berguna untuk membuat bentuk yang anda sukai, namun berbasis garis. Anda dapat 
memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan shortcut 
key Y pada keyboard.  
 j. Brush Tool  
Tool ini berguna untuk membuat bentuk objek yang berbasis brush. Anda dapat memilihnya 
dengan memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key B pada 
keyboard.  
 k. Free Transform Tool  
Tool ini berguna untuk merubah / transformasi bentuk berupa ukuran, rotasi, maupun skew. 
Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan 
menekan shortcut key Q pada keyboard.  
 l. Fill Transform Tool  
Tool ini berguna untuk merubah warna gradasi. Anda dapat memilihnya dengan memilihnya 
pada icon dalam Toolbox atau dengan menekan shortcut key F pada keyboard.  
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 m. Ink Bottle  
Tool ini berguna untuk mewarnai garis tepi objek / stroke. Anda dapat memilihnya dengan 
memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key S pada keyboard.  
 n. Paint Bucket Tool  
Tool ini berguna untuk mewarnai objek / fill. Anda dapat memilihnya dengan memilihnya 
pada icon dalam Toolbox atau dengan menekan shortcut key K pada keyboard.  
 o. Eyedropper Tool  
Tool ini berguna untuk menduplikat warna. Anda dapat memilihnya dengan memilihnya 
pada icon dalam Toolbox atau dengan menekan shortcut key I pada keyboard.  
 p. Eraser Tool  
Tool ini berguna untuk menghapus objek. Anda dapat memilihnya dengan memilihnya pada 
icon dalam Toolbox atau dengan menekan shortcut key E pada keyboard.  

 

2. View Dalam bagian ini berisikan tool untuk merubah tampilan atau display dokumen, 

dimana sangat berguna jika anda ingin memperbesar atau memperkecil tampilan layer 

untuk melihat detail dari sebuah objek.  

1 Hand Tool  
Tool ini berguna untuk menggeser layer seperti halnya tangan. Anda dapat memilihnya 
dengan memilihnya pada icon dalam Toolbox bagian view atau dengan menekan shortcut 
key H pada keyboard.  
2 Zoom Tool  
Tool ini berguna untuk memperbesar atau memperkecil layer seperti halnya lup. Anda dapat 
memilihnya dengan memilihnya pada icon dalam Toolbox bagian view atau dengan 
menekan shortcut key M atau Z pada keyboard.  
 

3. Colors Dalam bagian Color ini berisikan tool untuk merubah warna dari objek dabik itu 

berupa warna stroke maupun fill.  

1 Stroke Color Tool  
Stroke Color berguna untuk mewarnai bentuk stroke atau garis luar dari objek.  
2 Fill Color Tool  
Fill Color berguna untuk mewarnai bentuk fill atau warna dalam dari objek.  

 

4. Options Dalam bagian ini berisikan macam-macam option yang digunakan untuk 

melakukan modifikasi objek. Option dalam bagian ini dinamakan modifier dimana jenisnya 

bermacam-macam tergantung dari objek yang kita pilih.  
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MENGGUNAKAN TOOLS  
1. Rectangle Tools   

Kita dapat membuat bentuk kotak maupun persegi menggunakan tools ini dengan berbagai 
warna maupun style. Untuk membuatnya, ikuti langkah-langkah berikut”  

1. Klik Rectangle tools  pada toolbar  
2. Klik drag pada halaman kerja membentuk kotak  
3. Sesuaikan dengan ukuran yang diinginkan  
4. Menggunakan Arrow tools  , klik pada gambar.  
5. pada fill color pilih warna yang anda sukai.  
 

Membuat kotak dengan sudut tumpul :  
1 Pilih Rectangle tools  
2 Klik option  
3 Pada kotak dialog yang muncul, masukkan angka 45  
4 gambarlah kotak pada stage  
 
 
 
� 2. Ovale Tools  
Ovale tools digunakan untuk membuat bentuk lingkaran. Untuk membuatnya ikuti langkah-
langkah berikut:  
1. Pilihlah Ovale tools  
2. Klik dan drag untuk membuat lingkaran pada halaman kerja  
3. Untuk membuat lingkaran sempurna, tekan tombol shift ketika membuat lingkaran. 

 
� 3. Pencils Tools  
Penggunaan pencils tools sama dengan menulis menggunakan pensil. Ada beberapa mode 
pilihan menggunakan pencils tools, yaitu:  
1. Straighten mode, digunakan untuk membuat bentuk dengan garis lurus-lurus.  
2. Smooth mode, digunakan untuk membuat bentuk dengan sudut halus. 
3. Ink mode, digunakan untuk membuat betuk yang lebih bebas.  
a. Line Tools  

Line tools digunakan untuk membuat bentuk lurus. Apabila anda bermaksud membuat garis 

lurus dengan perbedaan sudut 45
0 
, maka tekan shift ketika membuat garis.  

b. Text Tools  

Flash memberikan 3 pilihan jenis teks, yaitu:  

1 Static text, yaitu teks sederhana yang biasanya digunakan untuk membuat label.  
2 Dinamic teks, yaitu teks yang dapat digunakan untuk menampilkan teks dari luar.  
3 Input teks, yaitu teks yang digunakan untuk meminta input dari user. Misalnya pembuatan 
form isian.  
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c. Paint Bucket  

Tools ini digunakan untuk memberi warna pada objek yang diinginkan.  
1 Buatlah objek lingkaran.  
2 Klik pada paint bucket tools. Pada bagian fill color, pilih warna yang anda sukai.  
3 Klik pada objek yang akan diberi warna.  
 

d. Ink Bottle  

Penggunaan Ink bottle, seperti halnya paint bucket, namun penggunaan tools ini untuk mewarnai 

garis tepi objek.  

e. Brush Tools  

 Mewarnai menggunakan tools ini, akan menghasilkan goresan seperti menggunakan kuas. Ada 

beberapa pilihan yang dapat anda gunakan untuk mewarnai, yaitu:  

1 Paint Normal, digunakan untuk mengecat bagian objek dengan mode normal.  
2 Paint Fill, digunakan untuk mengecat bagian warna objek.  
3 Paint Behind, digunakan untuk mengecat bagian belakang objek.  
4 Paint Selection, digunakan untuk mengecat bagian yang terseleksi.  
5 Paint Inside, digunakan untuk mengecat bagian dalam objek.  
 

Untuk mencobanya, buatlah lima objek dengan warna yang berbeda dengan warna brush. 

Kemudian gunakan brush tool dengan mode yang berbeda-beda.  

� f. Lasso Tools  
 Lasso tool merupakan tool pemilih. Anda dapat melakukan seleksi dengan bentuk lurus maupun 
bentuk bebas.  

1. Pilih Lasso tool.  
2. Klik pada titik awal objek, drag mengikuti aliran pemilihan. 
3. Apabila pemilihan selesai, lepaskan mouse. 

 
Jika anda bermaksud melakukan pemilihan dengan bentuk selalu lurus, pada option 
tools, pilih Polygon tools kemudian lakukan seleksi dengan cara klik setiap titik 
pemilihan dan diakhiri pada titik awal seleksi. 
 
� g. Eraser Tools  
Tools ini digunakan untuk menghapus objek terpilih dengan beberapa pilihan:  

1. Eraser Normal, untuk menghapus objek yang dilewati eraser tools.  
2. Eraser Fill, untuk menghapus warna objek  
3. Eraser Lines, untuk menghapus garis tepi objek  
4. Eraser Selected Fills, untuk menghapus warna yang terpilih  
5. Eraser Inside, untuk menghapus bagian dalam objek  
6. Faucet Modifier, untuk menghapus satu bagian objek yang terkena faucet. Anda dapat 

mengubah ukuran penghapus dengan merubahnya pada tools option.  

 
� h. Eye dropper Tools  
Tools ini digunakan untuk mengkopi warna dari satu objek ke objek yang lain.  

1. Buatlah objek kotak dengan warna kuning.  
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2. Kemudian buat objek dengan warna hijau pada tempat yang berbeda.  
3. Pilih Dropper tools, klik pada objek kotak, kemudian klik pada fill objek lingkaran. Perhatikan 

hasilnya.  
� i. Zoom Tools  
Zoom tools digunakan untuk memperbesar tampilan objek.  
� j. Hand Tools 
 Apabila projek yang anda buat sangat besar, untuk melihat bagian yang diluar area preview dapat 
digeser dengan Hand tools.  

 

Mengenal Stage  
Stage dalam Flash berguna sebagai lembar kerja untuk pembuatan berbagai bentuk objek 

yang kita inginkan. Dalam Flash MX Profesional 2004 kita dapat langsung membuat 

berbagai bentuk objek dengan memilih Tool yang kita inginkan kemudian membuatnya 

dalam Stage yang tersedia.  

 

Mengenal Timeline  
Timeline dalam Flash berguna untuk mengatur letak dan waktu dari animasi sebuah objek. 

Dalam Timeline ini terdapat dua bagian utama yaitu Layer dan Frame.  

 

Dalam Timeline terbagi menjadi dua bagian yaitu :  

1. Layer Dalam bagian Layer ini berguna sebagai tempat meletakkan objek. Untuk 
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membuat sebuah layer anda dapat dengan menggunakan cara klik icon Add Layer  

 atau melalui Menu Insert > Timeline > Layer  

 
atau dengan cara klik kanan Layer > Insert Layer  

 
2. Frame Frame berfungsi untuk mengatur waktu dari objek ataupun animasi akan 

ditampilkan. Kecepatan frame yang dimainkan sangat berpengaruh dari framerate yang 

digunakan. Makin tinggi framerate maka akan makin cepat pula sebuah animasi akan 

dimainkan.  

 
Kecepatan framerate sebuah animasi dapat diatur dengan cara double click frame pada 

Timeline, kemudian memasukkan nilai framerate yang anda inginkan.  
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Mengenal Property Inspector  
Property Inspector dalam Flash berisi property dari objek yang kita pilih  menggunakan 
Selection Tool  . Tiap objek yang kita pilih memiliki property yang berbeda dengan objek 
lainnya. Sebagai contoh jika kita memilih objek lingkaran yang kita buat dengan Oval Tool  

 maka akan berbeda property-nya dengan teks yang kita buat menggunakan Text Tool  

 

 

Dalam Property Inspector ini kita dapat merubah tiap property dari objek yang kita pilih baik 

itu berupa objek, maupun animasi dengan merubah parameter dalam Property Inspector 

objek maupun animasinya.  

Mengenal Warna  
Dalam Flash, setiap objek yang dibuat akan dibuat dalam 2 warna, yaitu Fill color (warna 

dalam) dan Stroke color (warna luar/stroke). Setting kedua warna ini dapat dilakukan dari 

Tool Color dalam Toolbox, kemudian memilih salah satu warna dalam palet warna yang 

tersedia.  
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Sedangkan setting warna lebih lanjut dapat dilakukan dari Panel dengan memilih Panel 

Color Mixer sehingga akan terlihat seperti gambar berikut :  
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Mengenal Library  
Library dalam Flash berguna untuk menyimpan berbagai objek maupun symbol yang 

digunakan dalam aplikasi yang anda buat. Sebuah objek yang anda buat ataupun import ke 

dalam Flash maka secara otomatis akan ditempatkan dalam bagian ini. Library dapat 

ditampilkan dengan memilih dari menu Window > Library atau dengan menekan tombol Ctrl 

+ L dari keyboard.  
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Anda dapat memasukkan objek yang terdapat dalam Library ke dalam Stage dengan 

melakukan drag langsung objek dari Library ke dalam Stage.  

Mengenal Actionscript  
Dalam Flash kita dapat membuat objek dalam aplikasi yang kita buat menjadi lebih 

interaktif. Untuk membuat interaktivitas dalam Flash kita dapat mengunakan perintah 

perintah yang biasa disebut dengan Actionscript. Pada dasarnya actionscript yang kita buat 

hampir sama dengan bahasa pemrograman Javascript, maka jika anda telah terbiasa 

dengan bahasa pemrograman ini maka ini akan sangat membantu anda dalam membuat 

aplikasi menggunakan actionscript ini. Dalam actionscript anda harus memahami tiga 

macam komponen untuk membuat aplikasi anda menjadi lebih interaktif, yaitu :  
1 Event Merupakan peristiwa yang terjadi untuk memicu sebuah aksi pada objek  
2 Action Merupakan aksi atau kerja yang dikenakan atau diberikan pada suatu objek.  
3 Target  
 

Merupakan objek yang dikenai oleh aksi.  

Actionscript dalam Flash MX Profesional 2004 terdapat dalam panel Action yang dapat anda 

tampilkan dengan memilih menu Window – Development Panel – Action, atau dengan 

menekan tombol F9 pada keyboard.  
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Dalam Panel Action, anda dapat mengetikkan perintah langsung ke dalam jendela yang 

tersedia, atupun dengan memilih menu bantuan yang sudah disediakan pada panel ini.  

 
 

 
BAB III MENGGUNAKAN FLASH 

 

A. Mengatur Halaman Kerja  

1. Menampilkan Grid  

Grid digunakan untuk mempermudah pengaturan kesimetrisan halaman kerja. Untuk 

menampilkannya, pilih menu View – Grid – Show Grid atau dapat dengan menekan 

shortcut key Ctrl + ‘  
1 Menampilkan Garis Pilih menu View – Ruller atau dapat dengan menekan shortcut 
key Ctrl + Alt + Shift + R  
2 Mengatur warna dan ukuran stage Pilih menu Modify – Document hingga terlihat 
window Document Properties.  
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Dalam window document Properties tersebut anda dapat menentukan :  
1 Property Lebar dan Tinggi lembar kerja anda dalam kolom Dimension agar sesuai 
dengan yang anda inginkan.  
2 Background Color untuk mengganti warna latar belakang sesuai dengan warna latar 
yang anda inginkan.  
3 Frame rate untuk menentukan jumlah frame yang dimainkan per detiknya dengan 
ukuran fps atau frame per second.  
4 Ruler Unit untuk mengubah ukuran sesuai dengan yang anda inginkan.  
 

 

B. Membuat Animasi Tweening  
Seperti yang kita ketahui dalam Flash kita dapat membuat dua metode animasi yaitu 

Animasi Tweening dan Animasi Frame by frame. Dalam hal ini pertama kali kita akan 

membuat sebuah animasi dengan metode Tweening.  

1. Animasi Motion  

Animasi motion merupakan animasi dengan mode tweening. Untuk membuat animasi 

ini, hanya menentukan titik awal dan titik akhir, selebihnya dikerjakan oleh computer. 

Buatlah file baru, pilih menu File -New Sebagai contoh dengan menggunakan ovale 

tools, buatlah lingkaran pada  

stage disebelah kanan.  
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Dalam Timeline, klik kanan pada keyframe 1 -pilih Create motion tween. Klik kanan pada 

frame 20 -pilih insert keyframe  

 

 
Pindahkan lingkaran ke sebelah kiri dengan Arrow Tool (Flash MX) atau Selection Tool 

(Flash MX 2004)  

Catatan :  

Ingatlah letak keyframe yang sedang aktif, jika berada pada frame 20 maka animasi 

akan berjalan ke kiri. Sedangkan jika yang sedang terpilih adalah frame 1 maka 

animasi akan bergerak ke kanan. Maka Telitilah terlebih dahulu letak posisi kursor 

anda dalam Timeline!  

Jalankan animasi dengan menekan Enter. 

Lihat preview test movie dengan menekan Ctrl + Enter 

Ulangi langkah d dan e untuk keyframe 30, 40, dan seterusnya. 

 

2. Animasi Motion Guide  
� a. Buatlah file baru, pilih menu File -New  
� b. Menggunakan Ovale tools, buatlah lingkaran pada stage di sebelah kanan.  
� c. Klik kanan pada keyframe 1 -pilih Create motion tween  
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� d. Klik kanan pada frame 60 -pilih Insert keyframe  
 e. Klik kanan pada layer 1 -pilih Add motion guide  
 f. Akan terbentuk sebuah layer baru bernama Motion Guide  
� g. Klik frame 1 pada layer Motion guide yang terbentuk kemudian dengan 
Menggunakan pencil tools, buatlah lengkungan sebagai lintasan.  
� h. Klik pada frame akhir / 60 pada layer 1, pindahkan objek ke titik terakhir garis.  
� i. Jalankan animasi dengan menekan tombol Enter atau Test Movie dengan 
menekan tombol Ctrl + Enter  
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3. Animasi Mask  
� a. Buatlah file baru, pilih menu File -New  
� b. Menggunakan teks tool, buatlah tulisan dengan Text Tool. Tebalkan dan 
perbesar tulisan tersebut dari property teks di Property Inspector.  
� c. Klik kanan pada keyframe 40 -pilih Insert frame  
� d. Tambahkan layer baru menggunakan tombol add layer pada pojok kiri bawah 
timeline.  
� e. Pilih layer baru tersebut. Menggunakan Ovale tool, buatlah lingkaran di 
sebelah kiri teks.  
� f. Klik kanan pada frame 40 -pilih Insert keyframe  
� g. Pindahkan lingkaran ke sebelah kanan teks.  
� h. Klik kanan pada frame 1 -pilih create motion tween. Lakukan pada frame 15  
� i. Pilih layer 2 (layer paling atas) -pilih mask  
� j. Jalankan animasi dengan menekan control+Enter  
 

4. Animasi Alpha  
� a. Buatlah file baru, pilih menu File -New  
� b. Menggunakan Pen tool, buatlah bentuk bintang.  
� c. Klik kanan pada keyframe 10 -pilih insert keyframe  
� d. Klik kanan pada frame 1 -pilih create motion tween. Lakukan pada frame 10  
� e. Pilih frame 1. Dalam kolom color di Property Inspector ubah property dari none 
ke alpha.  
� f. Pada kotak pilihan alpha, masukkan nilai antara 0% hingga 100 % pada kotak 
prosentase untuk memberi efek penampakan objek.  
� g. Jalankan animasi anda  
 

5. Animasi Transform  
� a. Buatlah file baru, pilih menu File -New  
� b. Menggunakan Rectangle tools, buatlah kotak persegi panjang.  
� c. Klik kanan pada keyframe 1 -pilih Create motion tween  
� d. Klik kanan pada frame 5 -pilih insert keyframe, kemudian  
� e. Pilih tool Free Transform.  
� f. Klik objek bantu persegi panjang yang terbentuk, transformasikan ke bentuk 
yang anda inginkan.  
� g. Jalankan animasi dengan menekan enter.  
 

6. Animasi Shape  
� a. Buatlah file baru, pilih menu File -New  
� b. Menggunakan ovale tools, buatlah bentuk lingkaran.  
� c. Klik kanan pada frame 20 -pilih Insert Blank Keyframe  
� d. Menggunakan rectangle tool, buatlah objek kotak.  
� e. Pilih frame 1.  
� f. Dalam kolom Tween pada Property Inspector ubah property Tween menjadi 
Shape  
� g. Jalankan animasi anda.  
 

7. Animasi Frame by Frame  

a. Buatlah file baru, pilih menu File -New  

d. Function Kategori ini berisi action yang dapat menerima data tertentu dan kemudian 
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menghasilkan informasi.  

e. Properties  

Berisi informasi property pada objek  

f. Objects  

Memiliki kelas objek yang sudah didefinisikan.  

Variabel dan Tipe Data  
Ada empat macam tipe data, yaitu :  
� a. Number, untuk angka tertentu. Contoh, myScore = 100.  
� b. String, Kumpulan berbagai angka, huruf maupun symbol. Contoh, myName-
“abcd”  
� c. Boolean, Nilai yang berisi true atau false. Contoh, radiobutton=true.  
� d. Object, Nama objek yang dibuat berdasarkan instantiate, contoh, myColor = 
new Color.  
 

Operator  
Operator terbagi menjadi 3, yaitu :  
� a. Assigment operator (=), digunakan untuk menetapkan nilai suatu variable.  
� b. Aritmethic operator, berisi simbol-simbol matematika.  
 

Simbol  Keterangan  

+  Penambah bilangan  

- Pengurang bilangan  

*  Perkalian  

/  Pembagi  

++  Menambah dengan nilai 1  

 Mengurangi dengan nilai 1  

+=  Menambah suatu nilai pada variabel  

-=  Mengurangi suatu nilai pada variabel  

*=  Mengalikan suatu nilai pada variabel  
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1 Langkah berikutnya yaitu memilih type-type yang akan digunakan.  
2 Jika selesai. Klik tombol Publish -OK.  
 

 
 

BAB IV ANIMASI 3D DENGAN SWIFT 3D 
Program Pendukung Macromedia Flash  

Dukungan terhadap Macromedia Flash belakangan ini semakin luas, format Flash 

Movie *.SWF kini dapat dibuat tidak hanya oleh Macromedia Flash saja. Aplikasi lain kini 

memasukkan *.SWF sebagai format file yang dapat dieksport dari aplikasi trsebut, misalnya 

Adobe Illustrator atau CorelDraw. Jika anda telah membuat gambar pada aplikasi-aplikasi 

tersebut, anda dapat langsung mengekspornya ke dalam Flash. Tidak hanya apliaksi, 

bahkan kini scripting PHP pun dapat membuat format *.SWF. tidak hanya itu saja format 

SWF juga dapat digunakan untuk menampilkan berbagai animasi 3D dengan didukung oleh 

program pendukung atau 3
rd 

party software yang mendukung ekstensi ini. Salah satu 

program pendukung ini adalah Swift 3D keluaran dari Electric Rain atau Erain.  

Yang Terbaru dari Swift 3D versi 3  
1. Dukungan Vector  

Dalam program Swift 3D versi 3 ini berisi banyak fasilitas baru diantaranya adalah 

tentang penambahan feature baru ke dalam RAViX rendering engine yang menyediakan 

teknik yang tepat dalam pembuatan objek 3D dan kemudian dapat digunakan ke dalam 

Flash MX yang menyediakan feature-feature baru untuk penambahan dan metode-
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metode baru yang nantinya akan diinterintegrasikan dalam Flash movie. Dan kelebihan 

lainnya dari versi 3 ini adalah fasilitas rendering engine yang benar-benar baru yang 

lebih baik dari versi sebelumnya.  

2. Reflektif  
Swift 3D versi 3 menyediakan kemampuan untuk membuat objek menjadi terlihat seperti 

memantulkan cahaya, ini adalah salah satu efek yang mengasikkan dalam versi terbaru 

dari Swift 3D ini. Dengan meng-apply material yang ada ke dalam objek dalam scene, 

maka akan terlihat efek 3D yang telah kita buat akan menjadi lebih hidup dan terlihat 

nyata di tiap permukaannya. Dengan feature baru ini memberikan kemudahan bagi kita 

untuk lebih memanipulasi scene kita untuk meningkatkan objek yang kita buat menjadi 

lebih nyata  

3. Specular Highlight Sejak versi 2 dirilis, Swift 3D telah memiliki kemampuan untuk 

pembuatan specular highlights, tapi dalam versi 3 fasilitas ini lebih ditingkatkan menjadi 

lebih realistis, dan dalam versi 3 ini lebih ditingkatkan tingkatan pengontrolan melalui 

specularity dari objects yang memungkinkan kita untuk lebih meningkatkan pengaturan 

cahaya yang terlihat dalam sebuah objek. Selain itu, kita juga dapat lebih akurat dalam 

lokasi dan bentuk dari specular highlight tersebut, sehingga rendered scene anda 

menjadi lebih hidup namun dengan ukuran file yang jauh lebih kecil.  

4. Efek Bayangan Efek bayangan sebenarnya telah hadir sejak Swift 3D versi 2 

dikenalkan, namun dalam versi terbarunya ini kemampuan dari material untuk efek 

bayangan ini lebih ditingkatkan menjadi lebih realistis. Dalam versi 3 ini telah dilengkapi 

dengan lebih dari 32 efek bayangan cahaya untuk dapat diaplikasikan dalam scene kita 

hanya dengan meng-apply material dari efek yang telah tersedia tersebut ke dalam 

bentuk objek yang kita buat. Dalam Swift 3D versi 3 ini dilengkapi dengan berbagai tool-

tool yang diperlukan untuk dapat membuat berbagai bentuk output vector yang lebih 

realistis. Pembuatan objek 3D mulai dari bentuk sederhana hingga objek 3D dengan 

kualitas tinggi  
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Interface Software Swift 3D  

A. Properties Toolbar  

B. Animation Toolbar / Animation Timeline  
C. Trackball Toolbar  
D. Lighting Toolbar  

E. Gallery Toolbar  
F. Edit Toolbar  

G. Hierarchy ToolBar  

 

Membuat Animasi Teks 3 Dimensi  
1 Buka aplikasi dari Start – Programs -Swift 3D 3.00 -Swift 3D  
2 Click icon Create Teks di dalam menu bar  
3 Akan muncul setting teks pada property di sebelah kiri window.  
4 Ubahlah Teks menjadi teks yang diinginkan pada Kolom teks, dan setting font ke font 
yang dikehendaki. Contoh : b0nk3y dengan font Bold Italic  
5 Akan terlihat teks seperti yang dituliskan ke dalam Viewport.  
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6. Ubah ukuran atau skala dengan memilih icon Scaling Mode untuk merubah ukuran teks 

pada viewport.  
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1 Pilih Material pada panel Material, contoh : Glossy  
2 Klik Tahan (Drag and Drop) salah satu warna material ke objek teks yang dibuat  
 

 

 
hingga terlihat seperti gambar dibawah ini  

 
9. Pilih Panel Show Animation  

 
10.Pilih Horizontal Left Animation. Kemudian klik tahan (Drag and drop) ke objek teks pada 

viewport.  

11.Klik tombol Play Animation pada Animation Timeline dan akan terlihat hasil animasi yang 

telah dibuat sebelumnya.  
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Export Hasil Animasi Ke dalam Format SWF ( Shockwave Flash)  
1 Pilih Preview and Export Editor Bar  
2 Pada Output Option, pilih tombol Vector, lalu pilih General.  
3 Kemudian pada Target File Type pilih drop down untuk memilih Flash Player (SWF) 
yang berguna untuk merubah ekstensi ke dalam ekstensi SWF  
4 Pilih tombol Generate All Frames untuk mengubah ke dalam frame, sehingga animasi 
terlihat pada Render Preview  
5 Sesudah seluruh frame terisi, kemudian pilih tombol Export All Frames  
6 Akan terlihat sebuah menu Export Vector File. Lalu simpanlah hasil teks yang telah 
anda buat tadi.  
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Membuat Modelling dengan Extrusion Editor  
1 Pilih Extrusion Editor di sebelah Scene Editor.  
2 Buatlah bentuk objek seperti gambar dibawah ini.  
3 Kembali ke Scene Editor, dan setting style pda bevel menjadi outer round.  
4 Pilih Sizing untuk mengatur lebar, tinggi, serta kedalaman objek.  
5 Masukkan Material ke objek  
6 Pilih material animasi seperti Horizontal Left dan Drag ke objek  
7 Export hasil akhir ke ekstensi SWF  
 

Membuat Modelling dengan Lathe Editor  
1 Pilih Lathe Editor di sebelah Extrusion Editor.  
2 Buatlah bentuk objek seperti gambar dibawah ini.  
3 Kembali ke Scene Editor, dan pilih radial smoothing pada Lathe.  
4 Pilih Sizing untuk mengatur lebar, tinggi, serta kedalaman objek.  
5 Masukkan Material ke objek  
6 Pilih material animasi seperti Horizontal Left dan Drag ke objek  
7 Export hasil akhir ke ekstensi SWF  
 
Memasukkan objek ke dalam Macromedia Flash  
1 Bukalah aplikasi Macromedia Flash MX dari Start – Programs – Macromedia –
Macromedia Flash MX  
2 Import objek & teks 3 dimensi yang telah dibuat dari program Swift 3D menggunakan 
perintah File – Import to Library dan Import-lah objek & teks 3 dimensi yang telah diubah 
menjadi ekstensi SWF tadi.  
3 Setelah di-import, maka otomatis objek akan masuk ke dalam Library. Bukalah 
Library dari Windows – Library atau melalui shortcut tombol F11.  
4 Drag / klik tahan objek dari Library ke Stage untuk memasukkan objek dari Library ke 
dalam Stage.  
5 Simpan File ke dalam directory yang diinginkan  
6 Mainkan animasi yang dibuat dengan memilih menu Control – Test Movie atau 
melalui shortcut Ctrl – Enter  
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BAB V SOUND EDITING 

Banyak sekali software untuk sound editing yang telah ditawarkan dengan berbagai 

kelebihan baik dari fungsinya yang dapat menangani berbagai macam format audio hingga 

kemudahan penggunaannya. Disini akan dijelaskan tentang penggunaan sebuah software 

sound editing yang paling banyak digunakan untuk kebutuhan pembuatan sebuah 

soundtrack film maupun editing musik konvensional yaitu Adobe Audition.  

Adobe Audition 1.0  

 
Adobe

® 

Audition
TM 

adalah sebuah aplikasi digital sound editor, multitrack digital audio 

recorder, editor, dan mixer untuk pengguna system operasi Windows 98SE, Windows ME, 

Windows 2000, dan Windows XP keluaran dari Adobe Inc.  

bagi PC berbasis Windows. Anda dapat menggunakannya untuk recording dan 

memodifikasi sebuah file dengan ekstensi *.wav, *.mp3, *.mp3PRO, *.wma, *.mid dan 

ekstensi audio lainnyua. Atau jika anda ingin membuat sebuah sebuah lagu dengan 

berbagai suara lengkap dapat anda lakukan dengan aplikasi ini. Didikung pula dengan fitur-

fitur lainnya seperti built-in CD ripping membuat aplikasi ini banyak dipilih oleh banyak editor 

sound untuk mendapatkan kualitas sekelas CD dengan ukuran file yang relatif kecil.  
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Edit View Screen  

 
Multitrack View Screen  

 
Recording Sound  
1 Gunakan Edit View Screen untuk membuat sebuah rekaman dengan single track 
audio  
2 Pastikan microphone atau media yang akan anda rekam sudah dalam keadaan aktif  
3 Klik tombol Record pada Transport Button  
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4 Akan muncul sebuah window untuk pengaturan waveform sound yang anda.  
5 Pilihlah setting waveform sesuai dengan gambar diatas, dan klik OK  
6 Begitu anda tekan tombol OK, maka otomatis Adobe Audition akan langsung 
melakukan perekaman dengan setting sesuai dengan yang diisikan tadi.  
 

 
Memberi Effect pada Sound  

Jika anda telah melakukan perkaman suara, anda dapat pula memberikan sedikit effect 

pada file sound anda dengan cara :  
1 Pilih panel Effect pada organizer window  
2 Bloklah file suara anda untuk memilih file suara  
3 Klik salah satu effect untuk di aplikasikan pada file sound anda  
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